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1 About these exercises 

These exercises provide an overview of the key tools and features in CES Selector, and form a set of 
tutorials to help you familiarize yourself with the software. You can work through them in order, or 
pick and choose relevant ones, to learn about and try out different software features. 

There are also Quick Start Videos provided online to teach you about CES Selector. The exercises in 
this booklet can be used independently of the videos, or used alongside them, to test and check your 
knowledge. 

The exercises here are divided into two sections: 

• Section 2, Getting started with CES Selector provides an overview of the main selection 
and charting features in CES Selector, including: 

o Browsing 

o Searching 

o Charting 

o Filtering 

o Comparison tables 

o Find similar 

• Section 3, Getting the most out of CES Selector provides an introduction to additional 
tools and features for advanced selection methods, including: 

o Favorites 

o Eco Audit Tool 

o Synthseizer Tool 

o User-defined records 

o Performance indices 

 

http://www.grantadesign.com/support/cesresources/2019/videos.htm
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2 Getting started with CES Selector 

The exercises in this section give an overview of CES Selector and will teach you how to use the core 
functionality.  

In the next section (Getting the most out of CES Selector), you will find exercises that go into further 
detail, exploring some of the software’s more specialized features. There is also comprehensive 
online help accessible from the software that gives more detailed guidance. 

2.1 Main tools in CES Selector 

There are three main tools in CES Selector: Browse, Search, and Chart/Select. 

BROWSE – Explore the database 

 

The Browse tree allows you to explore the 
database, drilling down into the database record 
hierarchy.  

Records in the database are presented in a 
hierarchical tree structure, table by table. At the 
top level of the tree are the main ‘families’ of 
materials. At the bottom level are specific 
materials — for example High density concrete, 
6063 T6 Aluminum. 

In the MaterialUniverse table (shown left), 
material records are organized into four broad 
‘families’: ceramics and glasses, hybrid materials, 
metals and alloys, and polymers.  Each family is 
made up of ‘classes’ (Ferrous, Precious metal 
alloys, for example) which may contain ‘sub-
classes’ (Alloy steels, Low alloy steel, Cast) 
consisting of many ‘members’ (SAE 4130, for 
example).  

The categories and hierarchy presented in the 
Browse tree are specific to each data table: for 
example, in ProcessUniverse, the records contain 
process data rather than material data, and are 
organized by process type: Joining, Shaping, 
Surface treatment. 
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SEARCH  – Find information fast 

 

You can find materials or processing methods 
using a simple keyword search. Double-click a 
record in the Search results list to open its 
datasheet; the search term will be highlighted 
wherever it appears. 

You can also perform more advanced queries 
here, for example, using AND, OR and NOT, or 
searching for phrases ("steel alloy").  

SELECT  – Systematic materials selection 

 

The central hub of CES Selector is a powerful 
selection engine that identifies records that meet 
an array of design criteria and enables trade-offs 
between competing objectives. 

A simple 'wizard style' user interface guides you 
through a systematic rational selection process, 
making it quick to apply the methods pioneered 
by Granta founder Professor Mike Ashby. 

Graphical tools enable you to make and present 
decisions. Explore materials space, focus on likely 
candidates, study trade-offs between cost, 
engineering performance, and eco behavior. 

Structured, repeatable methods ensure you 
make the right materials choice for your 
application, e.g., to optimize performance per 
unit of function, and to minimize cost. 

 

The following exercises cover the use and functionality of these tools.  
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2.2 Browsing and Searching 

Exercise 1 — Opening a Database 

On starting CES Selector, the Databases window will appear, showing all installed databases (if more 
than one database is installed). The following exercises use the MaterialUniverse and 
ProcessUniverse tables which are supplied with all editions of CES Selector. 

When you select a database name in the Databases window, the database homepage then appears. 
Hover over a data module to see the data tables it contains. For example: 

 

Click the More information on data and usage link to see a detailed description of a data module.  

❖ Select different tables and read about the available data and applications 

Click a table in the Database Homepage to select it and see information about it. You can also 
change the selected table from the graphic on the More information page. 

❖ Change to the PROCESSUNIVERSE table 

Click MaterialUniverse>Processes and notice that the Browse tree updates. 

❖ Close the HOMEPAGE 

Click the cross at the top of the Home tab. This page can be reopened at any time by clicking 
Home on the main toolbar.  

❖ Change to the MATERIALUNIVERSE table 

With the Homepage closed, navigate to different tables using the Table list in the Browse 
window.  

Search SelectBrowse

Table:

Subset:

MaterialUniverse

All materials
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Exercise 2 — Browse Materials 

❖ Select the Table MaterialUniverse and the Subset All materials. 

Search SelectBrowse

Table:

Subset:

MaterialUniverse

All materials

MaterialUniverse

Ceramics and glasses

Hybrids: composites, foams...

Fibers and particulates

Magnetic materials

Metals and alloys

Polymers: plastics, elastomers
 

❖ Browse for a record for STAINLESS STEEL 

 

❖ Browse for a record for CONCRETE 

 

❖ Open the GENERIC record for POLYPROPYLENE  

Generic records are records at the folder level and give general information on the material, 
rather than data on a specific variant. They have their own icon: . 

❖ Open a specific POLYPROPYLENE record 

Double-click the record name in the tree to view the datasheet. 

Click  next to the property name to view design notes, which provide background 
information on properties, test notes, and selection guidelines.  

Right-click the datasheet to see a menu with further actions e.g., to locate the record in the 
Browse tree, copy the datasheet, print the datasheet, or export the data to an FE package 
format. 

❖ Find PROCESSES that can shape POLYPROPYLENE using the ProcessUniverse link at the 
bottom of the datasheet 
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Part of a datasheet for a filled polypropylene material: 

  

The design note for Young’s modulus: 

 

For more information on the property and to drill down to the underlying science, follow the 
hyperlink to the science note. 
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Exercise 3 — Browse Processes 

❖ Select the Table ProcessUniverse and the Subset All processes. 

ProcessUniverse

Search SelectBrowse

Table:

Subset:

ProcessUniverse

All processes

Surface treatment

Shaping

Joining

 

❖ Browse for a record for FRICTION WELDING (METALS) 

 

❖ Browse for a record for TRANSFER MOLDING 

 

❖ Browse for a record for ION IMPLANTATION 

 

❖ Find materials that can be DIE CAST, using the link to MaterialUniverse at the bottom of a 
record for DIE CASTING 
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Exercise 4 — Searching 

❖ Find the material POLYLACTIDE 

Browse SelectSearch

Polylactide

 

❖ Find the process VACUUM ASSISTED RTM 

The folder name is also included in the search. If the term appears in a folder name, all 
records under that folder will be returned; for example, a search for ceramic would return all 
records in the folder named Ceramic. 

❖ Find the materials for CUTTING TOOLS 

Text on the datasheet is also included in the search. 

❖ Enter the search term ALUM* 

Returns records starting with Alum, such as Alumina, Aluminum, and Alumino.  

More advanced searches 

The following search operators are available: 

AND Finds records containing both the search terms, so steel AND alloy 
returns only records containing both the words steel and alloy 

OR Finds records containing either search term, so steel OR alloy returns all 
records that contain steel, alloy, or both 

NOT Finds records containing the first search term, but not the second, so 
steel NOT alloy returns only records with the word steel but without the 
word alloy 

Phrase Search Finds the exact search term, so “steel alloy” will return only records 
containing the exact phrase steel alloy 

Parentheses Used to group search terms, so iron AND (ore OR cast) will return the 
records containing iron and containing either ore, cast, or both 

Note: AND operators are automatically added when a search has two or more terms and no other 
operators have been entered.  
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2.3 Comparing Records 

The performance of different materials can be compared by creating a Comparison Table. 

Exercise 5 — Compare records 

Search SelectBrowse

Table:

Subset:

MaterialUniverse

All materials

MaterialUniverse

...

Polymers: plastics, elastomers

Plastics

Thermoplastics

PP (Polypropylene)

Unfilled

Random copolymer, high flow

…

Set as Reference

Add to Comparison Table

...

 

❖ Add an unfilled PP (Polypropylene) and an unfilled high-density PE (Polyethylene) record to a 
COMPARISON TABLE. 

Find an example of each in the Browse tree, then right-click and select Add to Comparison 
Table. 

❖ Set PE-HD as the reference record 

Hover over the record name in the comparison table and click Set as Reference . 
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❖ Change the display to show the differences relative to the reference record as percentages 

Click % Change in the comparison table toolbar. 

❖ Clear the Comparison Table 

 

…

Reference Record

Comparison Table

...
Clear

View

All Tables

MaterialUniverse
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2.4 Creating property charts 

Bar charts and bubble charts are a great way to visualize and communicate materials properties, as 
well as being a key tool to support systematic materials selection. 

Exercise 6 — Create a bar chart 

❖ Select MaterialUniverse: All bulk materials 

 

❖ Make a bar chart of YOUNG’S MODULUS (E) 

Under Selection Stages, click Chart/Index. 

Set the y-axis attribute to Young's modulus, then click OK. 

For a bar chart, you do not set an x-axis, so leave x-axis set to <None>.  

Chart/Index Limit Tree

SearchBrowse Select

1. Selection Data

Select from: MaterialUniverse: All bulk materials

Reference: PE-HD (high molecular weight)

2. Selection Stages

Young’s modulusAttribute:

Y-axis

Single or Advanced Property

Chart Stage

 

❖ Explore the chart 

Click Zoom in  and then drag to zoom in on an area of the chart. 

Click Zoom out   to zoom out. 

Click Autoscale  to zoom back to view the whole chart again. 

❖ Label records on the chart 

Click a record in the chart and then drag to add and position a new data label.  

To delete a data label, select it and press DELETE. To delete all labels in the chart, press 
CTRL+A and then press DELETE. 
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Figure 1 A bar chart of Young’s modulus, with data labels 

Exercise 7 — Create a bubble chart 

❖ Make a bubble chart plotting YOUNG'S MODULUS (E) against DENSITY (ρ) 

Under Selection Stages, click Chart/Index. 

Set the y-axis to Young’s modulus and set the x-axis to Density.  

Use the Axis Settings defaults to create a log-log plot.  

Chart/Index Limit Tree

SearchBrowse Select

1. Selection Data

Select from: MaterialUniverse: All bulk materials

Reference: PE-HD (high molecular weight)

2. Selection Stages

DensityAttribute:

X-axis

Single or Advanced Property

Young’s modulusAttribute:

Y-axis

Single or Advanced Property

Chart Stage
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❖ Show family envelopes 

Click  to look at how data for a given family of materials cluster together. 

❖ Label records on the chart 

Zoom in and label some records (click a record and drag). 

Try adding labels from the Results list: right-click a record in the list, select Label on the 
shortcut menu, and then drag the label to where you want it on the chart. 

If the new label isn’t visible at the current zoom level, click Autoscale  to display the whole 
chart again. 

❖ Locate the Reference Record 

Click Highlight reference record  on the Chart Stage toolbar; all records except the 
reference record are grayed out.  

Label the reference record. Note that the label includes a special reference record indicator: 

 

❖ Delete this stage 

Select the stage in the Selection Stages list and press DELETE. 

 

Figure 2  Bubble chart showing Young’s modulus (E) plotted against density (ρ)  
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2.5 Filtering Records 

Exercise 8 — Selection Using a Limit Stage 

Chart/Index Tree

SearchBrowse Select

1. Selection Data

Select from: MaterialUniverse: All bulk materials

2. Selection Stages

Limit

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

Max. service temp.

Thermal conductivity

°C200

25 W/m.°C

Min Max

Limit Stage

Impact & fracture properties

Thermal properties

Electrical  properties

Electrical resistivity μohm.cm1e15

Min Max

Limit 

guidance

 

❖ Select materials with specific thermal and electrical properties. 

Create a new Limit Stage and enter the following criteria: 

MAX. SERVICE TEMPERATURE > 200 °C 

THERMAL CONDUCTIVITY > 25 W/m.°C 

ELECTRICAL RESISTIVITY > 1e15 μohm.cm 

Use the limit bars for guidance on suitable values. Enter the limits – minimum or maximum 
as appropriate – and click Apply. If a reference record is set, its values for each property will 
be shown to the right of the min/max entry boxes.  

Example results: Aluminum nitride, Alumina, Silicon nitride. 

Note:  These exercises have been written using the unit settings ‘US Dollar (USD)’ and 
‘Metric’. If you use different settings, the selection criteria and figures will differ. To 
change the settings, click Settings on the toolbar, and click the Units tab. 
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❖ Filter the results further to select only materials with non-opaque TRANSPARENCY. 

On the Limit Stage under Optical, aesthetic and acoustic properties, set the Transparency to 
Translucent, Transparent, and Optical quality.  

Click Apply.  

Example results: Alumina (translucent) and Diamond. 

❖ Delete this stage. 

Exercise 9 — Using the Engineering Solver 

Design requirements are often specified in terms of geometry, loading, and maximum deflections. 
The Engineering Solver tool converts these engineering requirements into material properties, which 
can then be applied in Limit stages to screen for suitable materials. 

❖ Open the Engineering Solver tool. 

Click Solver   on the main toolbar. 

❖ Select the situation Beam in Bending.  

This model estimates the minimum strength and stiffness values required for a beam with 
the specified geometry and load conditions. 

❖ Set up the geometry for an I-beam with the following cross-section dimensions. 

 

Use the Cross-section list to select I-section. Enter the following 
dimensions and use the lists at the end of each line to select the correct 
units: Breadth (b) 100mm; Depth (d) 250mm; Thickness (t) 10mm; 
Web thickness (tw) 10mm; Length (l) 5m. 
 

❖ Set up the design parameters for a cantilever with an end load of 5kN. 

Load conditions = Cantilever End load 

Load = 5kN 
Safety factor = 1.5 

Maximum deflection = 50mm 
The results will automatically populate. You should see that the minimum required Young’s 
Modulus is 133GPa and the minimum Yield Strength is 108MPa. You can change the units for 
the results using the adjacent lists.  

Keep the Engineering Solver window open. 

❖ Select materials based on the results from the Solver tool.  

Create a new Limit stage with All bulk materials, using the Young’s modulus and Yield 
strength results from the Engineering Solver.  

Enter the minimum Young’s modulus and Yield strength (elastic limit) values.  
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Make sure that the results units in the Engineering Solver and Limit Stage match: change the 
results units in the Engineering Solver if they do not match those in the Limit Stage.  

Example results: Alumimum, Alumina, Berylium, Bronze, Carbon Steel... as you can see, a 
large number of results are returned. It would then be standard to perform further selection 
stages to narrow down the list of potential materials (e.g. setting a maximum price). 

Exercise 10 — Selection Using a Chart Stage 

When plotted on a Chart Stage, records can also be filtered using the Index line and Box selection 
tools. This provides a more qualitative approach to filtering.  

SearchBrowse Select

Density

Y
ie

ld
 s

tr
e

n
g

th

Line 

selection

Y
ie

ld
 s

tr
e

n
g

th

Box 

selection

Bar chart1

Bubble chart2

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

Chart/Index Tree

2. Selection Stages

Limit

1. Selection Data

Select from: MaterialUniverse: All bulk materials

 

❖ Make a bar chart of YIELD STRENGTH (σy) 

Set the y-axis to Yield strength (elastic limit). 

❖ Use a box selection to identify materials with high values of YIELD STRENGTH 
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Click Box selection  , then drag to define the selection box. 

Box selection

 

❖ Add DENSITY (ρ) to the other chart axis 

Click Chart Settings , and on the x-axis tab, select Density as the axis attribute.  

❖ Use an INDEX LINE to identify materials with high values of the specific strength σy / ρ 

Click Index line . 

By default, the slope of the line is 1 and the objective is Maximize the index. This will result 
in selection of materials above the line, for high values of σy / ρ.  

Click OK and then click the chart to position the line through a particular point.  

Drag the line upwards to refine the selection to fewer materials. 

❖ Add a Box selection to the chart to identify materials with low DENSITY that maximize the 
index.    
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Index line

Box selection

 

❖ Rank the results by specific strength (YIELD STRENGTH / DENSITY) 

Show: Stage 1: Yield strength v. Density 

Rank by: Stage 1: Index value. 

Example results: Balsa, Polymethacrylimide foam, PVC. 

❖ Delete all stages 
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Exercise 11 — Selection Using a Tree Stage 

Using a Tree Selection Stage, you can filter records based on their links to records in other data 
tables, or based on the database hierarchy (tree). 

 

❖ Find materials that can be MOLDED 

Under Selection Stages, click  Tree. In the Tree Stage window, select ProcessUniverse, 
navigate to Molding. Select Molding, click Insert, and then click OK. 

❖ Click Show to see a list of the materials in MaterialUniverse to which this process is linked. 

 

❖ Delete this stage. 

 

❖ Find processes to join STEELS 

In the Selection Project pane, under Selection Data, select ProcessUniverse: Joining 
processes.  

Under Selection Stages, click  Tree. Select MaterialUniverse, expand Metals and alloys, 
select Ferrous, and then click Insert followed by OK. 

❖ Delete this stage. 
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2.6 Find Similar 

Materials in the database can be ranked based on their similarity, or nearness, to a specified 
material. This is useful for finding replacement or equivalent materials. The way in which nearness is 
calculated can be tailored to account for specific design requirements behind the initial material 
choice. 

Exercise 12 — Find Similar and Nearness Settings 

Name Nearness (%)

PVC (flexible, Shore A85)

TPU (Ether, aromatic, Shore D45)

EVA (Shore A85, 25% vinyl acetate)

PVC (flexible, Shore A65)

etc.

100

87

86

85



Comparison...

Records similar to: PVC (flexible, Shore A85)

Comparison - MaterialUniverse

Young’s modulus (GPa)

PVC EVA

0.0324

x Averages   #. Values  
Highlight 

% Change > 10

950Density (kg/m^3) 1330

0.0245

Datasheet 

PVC (flexible, Shore A85) Find Similar



 

❖ Open the datasheet for PVC (flexible, Shore A85)  

 

❖ Find similar materials  

Click Find Similar and confirm changing the reference record, if prompted.  

Available materials are ranked by their similarity to the reference material. In this instance, 
calculations are based on the default nearness criteria for this table.  

❖ Compare PVC with one of the near materials 

Select EVA (Shore A85, 25% vinyl acetate) and click Comparison. 

A comparison table is generated, showing the selected result and the reference record. 
Significant differences in the attribute values are highlighted. 
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2.7 Putting it all together 

Exercise 13 — Combining Filtering and Charting Tools 

SearchBrowse Select

2. Selection Stages

1. Selection Data

Select from: MaterialUniverse: All bulk materials

Reference: Not set Set...

Chart/Index TreeLimit

Limit stage

Density

Yield strength

T-conductivity

2000

60

10

Min Max

1

P
ri
c
e

Chart stage3

Surface

Process

Join

Shape

Tree stage2
3. Results X out of Y pass; ranked by PRICE

Material 1

Material 2

Material 3

Material 4

etc.

4. Reports

Comparison Selection

Casting

Forming

Deformation

Machining

Molding

Powder

 

❖ Choose the data source and set a reference record. 

Select from: MaterialUniverse: All bulk materials 

Reference: POM (homopolymer) 

❖ Select materials with specific physical, mechanical, and thermal properties. 

Add a Limit Stage with the following criteria: 

DENSITY < 2000 kg/m^3 

YIELD STRENGTH (Elastic limit) > 60 MPa 

THERMAL CONDUCTIVITY < 10 W/m.°C 

❖ Filter the results to find those that can be THERMOFORMED 

Add a Tree Stage and select ProcessUniverse - Shaping - Molding - Thermoforming. 

❖ Rank the results by PRICE 



 CES Selector 2019 Tour of features and getting started exercises 

© Granta Design 2018 25 

Add a Chart Stage with a bar chart of Price. On the Chart Stage, all materials that fail one or 
more stages are grayed out. The Results window lists the materials that pass all stages. 

In the Rank by list, select Stage 3: Price. 

❖ Compare the three cheapest materials 

Select the top three records in the Results list and click the Comparison button below the list 
to add them to a Comparison Table with the reference record. 

❖ Create a Selection Report 

Below the Results list, click Selection. 

A selection report is created, containing a summary of the selection project on the first page, 
details of each selection stage on the following pages, and the comparison table on the final 
page. 

Exercise 14 — Finding Supporting Information 

The following exercise requires an Internet connection. 

CES Selector translates the material ID to search strings compatible with a group of high-quality 
material and process information sources, and delivers the search results. Many of the sources 
require a subscriber-based password. The ASM source is particularly recommended. 

❖ Search the web to find more information on PET 

Open a PET datasheet, and then click Tools>Search Web.  
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Exercise 15 — Search and Find Similar 

❖ Search for a material and open its datasheet 

Use Search to find and display PC (high viscosity, molding and extrusion). 

❖ Find records similar to the selected record 

Click Find Similar . Use the default weightings to calculate nearness; do not open the 
Nearness Settings window. 

Selection Project...

Records Similar to: PC (high viscosity…)

Material 1

Material 2

Material 3

Material 4

etc.

Comparison...

Nearness (%)       Name

Datasheet 

PC (high viscosity, molding and extrusion)

Find Similar

Browse SelectSearch

PC

 

❖ Apply additional design constraints 



 CES Selector 2019 Tour of features and getting started exercises 

© Granta Design 2018 27 

Click Selection Project to create a selection project and rank the results by nearness to the 
reference record.  

Add a Limit Stage and select materials with equal or poorer flammability than the reference. 

 Slow-burning 

FLAMMABILITY Self-extinguishing  

 Non-flammable 

❖ Compare the selection results 

In the Results list, select PBT (general purpose) and PPE+PS alloy (15% glass fiber), then, 
under Report, click Comparison. 

❖ Use the comparison table to check for other significant differences in performance, for 
example, ELONGATION. 

SearchBrowse Select

2. Selection Stages

1. Selection Data

Select from: MaterialUniverse: All bulk materials

Reference: PC (high viscosity, mold...

Chart/Index TreeLimit

3. Results X out of Y pass

Material 1

Material 2

Material 3

Material 4

etc.

4. Report

Comparison Selection

Limit stage

Flammability

Durability: flammability

Reference:
Slow-

burning







Highly flammable

Slow-burning

Self-extinguishing

Non-flammable
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2.8 Process Selection 

Exercise 16 — Selecting Processes 

Ceramics

Hybrids

Metals

Polymers
Plastics

Material
Thermo-plastics

SearchBrowse Select

2. Selection Stages

1. Selection Data

Select from: ProcessUniverse: Shaping processes

Chart/Index Limit Tree

Limit stage1

Mass range

Range of section thickness

kg10 12

4 4 mm

1000Economic batch size (units)

Primary shaping processes 

Shape

Dished sheet 

Physical attributes

Process characteristics

Economic attributes

Tree stage2

Elastomers

Thermo-sets

1 2

 

❖ Choose the Selection Data. 

Select from: ProcessUniverse: Shaping processes. 

❖ Find PRIMARY SHAPING PROCESSES to make a component with specific shape, physical, and 
economic properties. 

Add a Limit Stage with five criteria: 

SHAPE Dished sheet 

MASS RANGE 10 - 12 kg 

SECTION THICKNESS 4 mm 

PRIMARY SHAPING PROCESS Yes 

ECONOMIC BATCH SIZE > 1000 

❖ Filter the results to only include THERMOPLASTIC materials 
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Add a Tree Stage and select MaterialUniverse - Polymers - Plastics - Thermoplastics. 

Example results: Compression molding, Rotational molding, Thermoplastic composite 
molding. 

2.9 Saving, Copying, and Report Writing 

Exercise 17 — Adding Comments and Saving a Project 

You can add comments to a selection project as a reminder of why you have applied certain 
constraints and objectives. Comments are displayed in the selection report, and are saved in the 
project file. 

Comments can be added to all selection stages in a project.  

 

❖ Click Notes   in the stage window heading, then enter some comments. 

❖ You can also add comments to the selection report summary and include, for example, 
information on which material was finally selected and the reasons why, to provide full 
traceability of the material selection. 

2. Selection Stages

Chart TreeLimit

Stage

Limit

Stage Settings

Title

Notes

Limit

Stage
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4. Reports

Comparison Selection

Report

Project Summary

Project Settings

Title

Notes

Limit

Summary

Author

Company

 

❖ Save the project 

On the File menu, click Save Project. Give the project a filename and directory location; the 
project will be saved with the file extension .ces.  

Exercise 18 — Exporting and Copying 

Reports can be exported as a PDF or as a Microsoft® Word document. 

❖ Generate a Selection Report 

 

❖ Export the report as a PDF 

Click Export   and select PDF.  

4. Reports

Comparison Selection

Report

Project Summary

PDF

Export

 
Note: You will require a PDF reader such as Adobe Reader® to view the exported selection 
report. 

Charts, records, and results lists can be copied and pasted into a document in another 
application such as Microsoft Word, Microsoft Excel, Microsoft Powerpoint, or Notepad.  
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❖ Copy a chart into a document. 

To copy a chart to the clipboard: in the chart window, right-click the chart and select Copy on 
the shortcut menu, or press CTRL+C.  

You can then paste the chart image from your clipboard into the document.  

❖ Copy a datasheet into a document. 

To copy a datasheet to the clipboard: display the datasheet and then right-click the 
datasheet and select Copy on the shortcut menu, or press CTRL+C. 

You can then paste the data from your clipboard into the document.  

❖ Copy results into a document. 

To copy results to the clipboard, use SHIFT+click or CTRL+click to highlight the records you 
want, then right-click and select Copy on the shortcut menu, or press CTRL+C. 

To select all results in the list, right-click and select Select All on the shortcut menu, or press 
CTRL+A. 

You can then paste the results from your clipboard into the document.  

❖ Edit the document you have created. 
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3 Getting the most out of CES Selector 

The following exercises introduce some additional tools and features designed for advanced 
selection methods. 

• 3.1 Custom Selection 

• 3.2 Performance Indices 

• 3.3 Functional Data 

• 3.4 Find Similar with Additional Criteria 

• 3.5 Eco Audit 

• 3.6 Synthesizer Tool 

3.1 Custom Selection 

Exercise 19 — Favorites 

The Favorites feature enables you to highlight your favorite records e.g. your company's preferred 
materials. 

❖ Browse to the CAST ALUMINUM folder and add the folder as a favorite 

Right-click the folder name and select Add to Favorites. This will add the folder and all 
records within that folder to favorites. On the browse tree and data labels, any favorite 
record will be marked with a star. 

Search SelectBrowse

Table:

Subset:

MaterialUniverse

All bulk materials

MaterialUniverse

Metals and alloys

Non-ferrous

Aluminum

Cast

Wrought

…

Add to Favorites

Remove from Favorites

 

❖ Add the TYPE 66 PA folder as a favorite as well 

Expand Polymers - Plastics - Thermoplastics - PA (Polyamide/Nylon) 

❖ Make a BUBBLE CHART of YOUNG’S MODULUS (E) against DENSITY (ρ)  

Select MaterialUniverse: All bulk materials and create a bubble chart as in Exercise 7.  
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❖ View your favorites on the chart. 

Click Highlight favorite records ; all the materials that are not favorites are grayed out. 
Add labels to some of your favorites. 

❖ Clear your Favorites 

On the Tools menu, click Favorites>Clear. 

❖ Retain this stage for the next exercise 

Exercise 20 — Adding user-defined records 

New materials are continuously being developed and introduced onto the market. These materials 
can be added and compared with other materials in the database using the User Defined Record 
feature. 

A user-defined record appears on the Browse tree under My records. 

User-defined records are saved in the selection project file, not the database.  

❖ Add a Limit selection stage with the following constraint: 

THERMAL EXPANSION COEFFICIENT < 100 μstrain/°C  

❖ Add a user-defined record 

Right-click in the bubble chart and select Add Record. 
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❖ Set the following values for the new record: 

NAME New material 

DENSITY Min. 1100 kg/m^3 

YOUNG’S MODULUS 70 - 75 GPa 

Click OK when finished. The new record will be shown on the Chart Stage with the default 
color as orange. 

Bubble chart

DensityY
o

u
n

g
's

 m
o

d
u

lu
s

Density

Young's modulus

kg/m^31100

70 75 GPa

Selection Attributes

Name: New material

Record Details

User Defined Record

Color:         Orange

Copy

Print...

Add Record

Thermal expansion coefficient μstrain/°C

 

❖ View the new record on the chart 

On the Stage toolbar, click Highlight user defined records  ; all the materials that are not 
user-defined are grayed out. 

When a record is added from a chart, only the selection attributes are shown for data entry. 
User-defined records do not fail stages when no value has been entered for a specified 
constraint (such as thermal expansion in this example). 

To edit or delete a user-defined record: right-click the record in the Browse tree and select 
the option on the shortcut menu. 

❖ Delete the Limit Stage, but keep the initial Chart Stage, as this will be needed for the next 
exercise 

 

❖ Save the project  

Exercise 21 — Selection with a Custom Subset 

The CES Selector databases are supplied with a range of standard subsets (e.g. All bulk materials, 
Metals, Magnetic materials) which enable users to restrict their material selection to certain material 
groups within the database. The custom subset feature enables you to define your own subsets. 
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❖ Define a custom subset 

In the Select from list, choose Custom: Define your own subset. 

Select ALUMINUM and PLASTICS and see that the bubble chart updates.  

In the Custom Subset dialog, use the check boxes to include or exclude records and folders. 

SearchBrowse Select

1. Selection Data

Select from: Custom: Define your own subset

Custom Subset

Selection attributes: All bulk materials

In itial subset: All bulk materials

Selection table: MaterialUniverse

MaterialUniverse

Ceramics and glasses

Fibers and particulates

Magnetic materials

Metals and alloys

Polymers: plastics, elastomers

Ferrous

Non-ferrous

Aluminum

Beryllium



...

Hybrids: composites, foams...

 
Note: The Selection attributes setting defines what properties will be available in chart and 
limit selection stages. 
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Exercise 22 — Record Coloring 

The CES Selector databases use a standardized color scheme for displaying records (e.g. blue for 
plastics). You can change the default colors to highlight particular records. 

Search SelectBrowse

Table:

Subset:

MaterialUniverse

<Custom>

MaterialUniverse

Metals and alloys

Polymers: plastics, elastomers

Thermoplastics

PP (Polypropylene)

Label

Record Color

Bring to Front

Yellow

Red

...

Lime

Blue

 

❖ Browse to the POLYPROPYLENE folder, right-click the folder name and change the record 
color to Yellow 

Note: Record colors can also be changed by right-clicking on a record in a chart stage or the 
selection results list.  

❖ Check that the record color on the bubble chart has updated 

 



 CES Selector 2019 Tour of features and getting started exercises 

© Granta Design 2018 37 

❖ Delete this stage 

Exercise 23 — Plotting a combined property 

Many engineering applications require combined properties to be optimized. For example, specific 
stiffness (Young's modulus / density) in aerospace, and thermal diffusivity (thermal conductivity / 
(density * specific heat)) in thermal applications. You can plot these types of properties using the 
Advanced property feature. 

❖ Make a BAR CHART of the combined property DENSITY / (YOUNG’S MODULUS ^ (1/2)) 

In the Chart Stage Wizard, under the Y-Axis tab, click Advanced. In the Set Axis dialog, select 
an attribute and click Insert to build the expression.  

Leave the x-axis with no attribute set, to generate a bar chart.  
 

SearchBrowse Select

Chart/Index Tree

2. Selection Stages

Limit

1. Selection Data

Select from: MaterialUniverse: All bulk materials

Advanced...

Y-axis

Chart Stage

Density / (Young's Modulus^(1/2))

 

❖ Delete this stage. 
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3.2 Performance Indices 

One of the main components of the rational material selection technique is the use of performance 
indices. These are combined properties (e.g. Young’s modulus / density) that allow the function of a 
design to be optimized for a particular application. The performance index finder enables users to 
quickly identify (and plot) the performance indices that are applicable to their design. 

Exercise 24 — Performance Index Finder 

❖ Make a BAR CHART of the performance index for minimizing the mass of a strength-limited 
beam, loaded in bending 

In the Chart Stage Wizard, under the Y-Axis tab, select Performance Index Finder. Select the 
Beam in bending function. Set section area as a free variable, strength as the limiting 
constraint, and optimize for mass.  

 

 

SearchBrowse Select

Chart/Index Tree

2. Selection Stages

Limit

1. Selection Data

Select from: MaterialUniverse: All bulk materials

Y-axis

Performance Index Finder

Chart Stage

Function:  Beam in bending

Limiting Constraint:  strength

Optimize: mass
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Exercise 25 — Selection with a Trade-off Plot 

Many designs require a compromise to be made between competing objectives, for example, 
maximize performance and minimize cost. The influence of this ‘trade-off’ on material choice can be 
studied by generating a trade-off plot, where candidate materials lie along a hypothetical curve or 
trade-off surface. You can identify optimal materials for a particular application by making a 
judgment on the relative importance of the two objectives (e.g. in aerospace, high performance is 
more important than low cost). 

❖ Make a BUBBLE CHART of the performance index BEAM IN BENDING, limited by STRENGTH 

Set the y-axis to optimize mass and the x-axis to optimize cost.  

SearchBrowse Select

Chart/Index Tree

2. Selection Stages

Limit

1. Selection Data

Select from: MaterialUniverse: All bulk materials

Performance Index 

P1: cost, c
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❖ Create a trade-off curve by adding a curve annotation to the chart 

On the chart stage toolbar, click  Curve.  

Click the chart at the points you want the curve to pass through.  

Press Enter to finish editing the curve.  

The curve is a guide to the eye, and does not perform selection. The materials closest to the 
trade-off curve offer the best compromise for minimizing mass and cost. 
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3.3 Functional Data 

Some properties within the databases are stored as functional data, meaning that data is available 
for a number of different conditions. This allows users to readily incorporate the conditions of their 
application into their selection project. For example, using the “Fatigue strength model”, you can 
specify both the stress ratio and number of cycles for the fatigue strength. 

Exercise 26 — Viewing Functional Data 

❖ Open the datasheet for a STAINLESS STEEL record. If the functional data graphs are not 
already visible, set them to be shown 

Click   Show/Hide to toggle functional data graphs on the datasheet.  

Use the graph buttons  to open a graph in a new window and view the equation or data 
points.  

Stainless steel, autenistic...

Stainless steel, autenistic...

Show/HideLayout: All attributes

Fatigue strength at 10ᶺ7 cycles

Fatigue stength model (stress range)

* 297 - 339 MPa

* 263 - 383 MPa

Mechanical properties

Number of cycles

Stress Ratio=-1
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Search SelectBrowse

Table:

Subset:

MaterialUniverse

Metals

MaterialUniverse

Metals and alloys

Stainless steel

Autenistic

Cast

ASTM CE

ASTM CE-30, cast...
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Exercise 27 — Setting Parameters for Functional Data 

The parameter values for functional data apply to all applicable functional data types within the 
datasheet and to all datasheets in the selection project. You change the parameter values using the 
Parameters hyperlink. 

Note: The value for Fatigue strength model is calculated at the given parameter values for Stress 
ratio and Number of cycles.  

❖ Find a record for STAINLESS STEEL 

 

❖ Change the parameter value for NUMBER OF CYCLES 

Click the Parameters link and set a new value in the dialog, then click OK. The value in the 
datasheet will be updated. 

 

❖ View the updated project setting 

Go to the Select menu and Project Settings. The updated settings are under the Parameter 
Values tab. 

Search SelectBrowse

Table:

Subset:

MaterialUniverse

Metals

Parameters

Value Information

Number of cycles 1e4

0Stress Ratio

Stainless steel, austenitic...

Stainless steel, austenitic...

Fatigue strength at 10ᶺ7 cycles

Fatigue stength model (stress range)

* 297 - 339 MPa

* 263 - 383 MPa

Mechanical properties

Parameters Stress ratio=-1, Number of cycles=1e7
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3.4 Find Similar with Additional Criteria 

If a project has additional or different constraints than are captured by the default nearness criteria 
in Find Similar, there are two ways to refine the results.  

Exercise 28 — Find Similar with Limits 

❖ Open the record for POLYPROPYLENE (COPOLYMER, CONDUCTIVE, 5% CARBON POWDER) 

 

❖ Find records similar to this one 

Click Find Similar. Use the default weightings to calculate nearness; do not open the 
Nearness Settings window. 

❖ Compare the current material with the nearest alternative 

Select the closest record from the list of results - PP (copolymer, 10% talc) - and open a 
comparison table using Comparison.  

The comparison table is highlighted where there is a difference between the original (reference) and 
alternative materials. The reference material in this exercise was chosen specifically because it has 
low electrical resistivity, however the nearest match does not. This is because the default criteria for 
nearness in this table do not account for electrical resistivity. You can change this manually.  
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PP (copolymer, conducti...

PP (copolymer, conductive, 5% carbon powder)

Find SimilarLayout: All attributes

Records similar to: PP (copolymer, conductive, 5% carbon powder)

Name Nearness (%)

PP (copolymer, conductive, 5% carbon powder)

PP (copolymer, 10% talc)

PP (copolymer, 20% calcium carbonate)

PP (impact copolymer, high flow)

etc.

100

96

95

94





Comparison...

Comparison

Comparison - MaterialUniverse

Density (kg/m^3)

    PP (carbon) PP (talc)

961 966

Electrical resistivity (μohm.cm) 3.16e11 7.14e23

30.7Compressive strength (MPa) 24.8

 

The nearest materials in the results have similar physical properties to the reference material 
(density, yield strength, Young’s modulus). However, the original material may have been chosen for 
other characteristics. In this case, the polymer is conductive (has a low electrical resistivity).  

The results from Find Similar can be used as the basis of a Selection Project. In this case, you can use 
a Limit Stage to filter on the additional requirement for conductivity. 

❖ Create a SELECTION PROJECT using the results 

In the Records similar to dialog, click Selection Project. The results are loaded into a new 
project, ranked by nearness. 

❖ Filter the results for electrical resistivity that is equal to or lower than the reference material 

Create a Limit Stage, and set the maximum value for electrical resistivity to 3.16e12, which is 
the maximum value for the reference record. Apply the stage. 



 CES Selector 2019 Tour of features and getting started exercises 

© Granta Design 2018 44 

Records similar to: PP (copolymer, conductive, 5% carbon powder)

Name Nearness (%)

PP (copolymer, conductive, 5% carbon powder)

PP (copolymer, 10% talc)

PP (copolymer, 20% calcium carbonate)

PP (impact copolymer, high flow)

etc.

100

96

95

94





Selection Project...

Chart/Index Limit Tree

2. Selection Stages

Limit Stage

Electrical  properties

Electrical resistivity μohm.cm3.16e12

Min Max Reference

3.16e10 – 3.16e12

 

Example results, with Nearness (%):PP (10-12%, stainless steel fiber) 89%, PP (10% carbon fiber) 86%, 
ABS (40% aluminum flake) 84%.  

❖ Delete this stage. 

Exercise 29 — Changing the Find Similar Nearness Settings 

Instead of filtering on additional attributes, it is possible to change the criteria used for calculating 
nearness to take account of different requirements. 

❖ Find records similar to POLYPROPYLENE (COPOLYMER, CONDUCTIVE, 5% CARBON POWDER) 

Open the datasheet and click Find Similar.  

❖ Re-calculate the list of alternative materials, taking ELECTRICAL RESISTIVITY into account and 
prioritizing those results with resistivity that is the same or lower than the reference 
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Click the Nearness settings link on the Records Similar to dialog.  

Under Electrical Properties, select Electrical resistivity, set it to 100% when Same or lower 
and increase the Weighting factor to 2. Click OK to generate the new results.  

Records similar to: PP (copolymer, conductive, 5% carbon powder)

Name Nearness (%)

PP (copolymer, conductive, 5% carbon powder)

PP (copolymer, 10% talc)

PP (copolymer, 20% calcium carbonate)

PP (impact copolymer, high flow)

etc.

100

96

95

94



Nearness settings

Nearness Settings

       Electrical properties

Electrical resistivity Same or lower

100% when

OK

Records similar to: PP (copolymer, conductive, 5% carbon powder)

Name Nearness (%)

PP (copolymer, conductive, 5 5% carbon powder)

PP (10-12% stainless steel fiber)

PP (10% carbon fiber)

ABS (40% aluminum flake)

etc.

100

91

89

87



Weighting factor

2

 

Note that these results are conceptually different to those from the previous exercise. These results 
rank similar materials, taking into account the conductivity, but there is not a fixed upper limit as 
there was when filtering using the Limit Stage. Materials with a higher conductivity than the 
reference will still be included in these results.  
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3.5 Eco Audit   

Only available in some CES Selector editions 

The Eco Audit Tool, which is an optional add-on for CES Selector, estimates the 
energy used and CO2 produced during five key life phases of a product (material, 
manufacture, transport, use, and end of life) and identifies which is the dominant 

phase. This is the starting point for eco-aware product design, as it identifies which parameters need 
to be targeted to reduce the eco-footprint of the product. 

In this case study: 

• A brand of bottled mineral water is sold in 1 liter PET bottles with polypropylene caps.  

• A bottle weighs 40 grams; the cap 1 gram.  

• Bottles and caps are molded, filled, and transported 550 km from the French Alps to England 
by 14 tonne truck, refrigerated for 2 days and then sold.  

• The overall life of the bottle is one year. 

An example product file for this case study is installed with CES Selector in the Samples folder, with 
the filename Bottle mineral water.prd. 

Product Definition 

The following details how the example product file has been created.  

For an explanation of the calculations used at each stage, click Help  in the heading.  
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1. Material, manufacture, and end of life 

Bill of materials (BoM), primary and (optional) secondary processing techniques. 

 

2. Transport 

Transportation from site of manufacture to point of sale. 

Sea freight

Rail freight

14 tonne truck

...

Air freight – long haul

Stage Name Transport type Distance (km)

Bottling plant to point of sale 1 4 tonne truck 550

14 tonne truck

 

3. Use 

Product Life and Location Use 

France

Germany

United Kingdom

...

Product life: years

Country of use:

1

United Kingdom

United Kingdom

 

Qty

Component 

name Material

Recycled 

content

Primary 

process

Secondary 

process

Mass 

(kg) End of life

Virgin (0%)
Polym er extrusion

Recycle

Landfill

Combust

Downcycle

Re-manufacture

Reuse

% 

removed

Polymer moldiVirgin (0%) 00.04PET .. .Bottle100

None

% 

recovered

Polymer molding

MaterialUniverse

PET

Polymer moldiVirgin (0%) 0.001PP (homogCap100

01Dead weight100

0

Recycle

Combust

None

100

100

100

Thermoplastics

Ceramics and glasses

Electr ical com ponents

Fibers and particulates

Hybrids: composites, ...

Metals and alloys

Polym ers: plastics, ... 

Magnetic materials
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Static Mode 

Energy used to refrigerate product at point of sale (average energy required to refrigerate 100 
bottles at 4°C = 0.12kW. 

Product uses the following energy:

Energy input and output:

Power rating:

Usage:

Usage:

days per year

hours per day

Electric to mechanical (electric motors)

0.12

2

24

kW
Fossil fuel to thermal, enclosed system

Fossil fuel to electric

Electric to thermal

...

Electric to mechanical (electric motors)

 

4. Report 

Summary chart enables rapid identification of the dominant life phase. Toggle between views of 
energy usage or CO2 footprint.  

 

The chart shows that, in this project, Material is the dominant life phase. Each life phase can be 
clicked to show guidance on strategies to reduce its impact.  

Detailed report provides a component-by-component breakdown of each life phase, enabling the 
main contributors to the dominant life phase to be identified.  

Exercise 30 — Compare Eco Audits 

❖ Open the Bottled mineral water product file. 

Click Open and locate the sample product file Bottled mineral water.prd, located in the 
Samples folder in your CES Selector installation folder. For example: 
C:\Program files (x86)\CES Selector 2019\Samples\eco_audit\Bottled mineral water.prd 

❖ Create a copy of this product for comparison 
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Click Compare with and select Copy of current product. 

Eco Audit Project

New Open Save Compare with      

Product definition

Copy of current product

New product

Saved product ...

Compare with      

 

❖ Set the following values in for the new product: 

NAME PET Bottle (Recycled) 

RECYCLED CONTENT 35% 

❖ Generate the SUMMARY CHART 

 

The first life energy (not including EoL potential) is reduced by 15%.  

Note: You can copy the chart into a document or print it using Copy and Print at the top of the chart 
window.  

Exercise 31 — Saving and Exporting 

Eco Audit projects do not form part of a selection project and therefore you will need to save them 
separately.  

❖ SAVE the product definition 
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Eco Audit Project

New Open Save Compare with      

Product definition Report

 

❖ GENERATE the Eco Audit report 

Click the Report tab (or click Detailed Report on the Product definition tab). 

❖ EXPORT the report as a PDF 

Note: You will require a PDF reader such as Adobe Reader to view the exported report. 

Product definition

Excel

PDF

Word

Eco Audit Project

New Open Save Compare with      

Report
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3.6 Synthesizer Tool 

Only available in some CES Selector editions 

The Synthesizer tool is designed for use in the early stage of product development. 
It consists of two types of models: hybrid models, for estimating the performance 
of novel materials and structures; and the part cost estimator, for calculating the 

cost of a component based on material and process chain. 

The Synthesizer tool enables you to compare the performance of these materials with other 
materials in the MaterialUniverse database. 

Exercise 32 — Sandwich Panels Model  

Hybrid materials and structures combine the benefits of two or more materials to produce new 
materials that exhibit unique combinations of properties. For example, both composite materials and 
sandwich panels are commonly used to create strong, lightweight structures.  

❖ Make a BUBBLE CHART of YOUNG’S MODULUS (E) against DENSITY (ρ) using 
MaterialUniverse: All bulk materials 

As in Exercise 7. 

❖ Use the SANDWICH PANELS MODEL to create synthesized records for a family of hybrid 
materials 

Click  Synthesizer on the toolbar (or click Tools > Synthesizer on the menu bar).  

Select the Sandwich Panels – Balanced model.  
Synthesizer

 

❖ Set the SOURCE RECORD values 

FACE-SHEET Aluminum, 6061, wrought, T6 

CORE Polymethacrylimide foam (rigid, 0.200) 

Click Browse and locate the records in the tree. 

❖ Use the default values for MODEL VARIABLES and MODEL PARAMETERS, and set the 
following RECORD NAMING values: 

FACE-SHEET Al 

CORE Rohacell 

❖ CREATE the synthesized records 

Click Create and then Finish. The new synthesized records will be shown in the Results list 
and on the Chart Stage. 

Note: The Help in the Synthesizer dialog opens further information about the current model 
type, including details of the calculations used.  
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❖ Plot an INDEX LINE corresponding to a lightweight, stiff panel in bending Ef
1/3/ρ 

Click  Index line, enter a slope of 3, and maximize the index. 

❖ Add labels to the source records and some of the synthesized records  

You can select individual records on the chart and drag to place a label. 

You can also add labels from the Results list: select one or more records  in the Results list, 
right-click and select Label on the shortcut menu, then then drag the labels where you want 
them on the chart. 

Click  Highlight synthesized records to help you identify the synthesized records on the 
chart.  

Use the Zoom controls  and  to zoom in to the area of interest on the chart. 

 

Synthesized records appear on the Browse tree under My Records and may be edited or deleted in a 
similar way to User Defined records.  

MaterialUniverse

...

My records

Synthesized

...

20mm core

Add Record

Edit Record

Delete Record

0.05mm Al face-sheet

0.0834mm Al face-sheet
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Exercise 33 — Part Cost Estimator 

The Part Cost Estimator is a synthesizer model that calculates the total cost of a component based on 
the material and processing costs. 

❖ Use the Part Cost Estimator to compare the cost of a component manufactured in two 
different ways: as an injection molded polymer, and as a rolled and pressed metal. 

Start Synthesizer Tool by clicking Synthesizer on the toolbar and in the dialog, select 
Cost – Part cost estimator. 

 

❖ Set the COMPONENT DETAILS: 

MATERIAL PP (copolymer, 20% talc) 

VALUE OF SCRAP MATERIAL 10% 

PART MASS 6.4 

PART LENGTH 10 

BATCH SIZE 1000 - 1E6 

NUMBER OF VALUES 10 

Note: for this exercise, the units of part mass and part length do not matter. 

❖ Set the PRIMARY SHAPING PROCESS values: 

PRIMARY PROCESS Injection molding (thermoplastics) 

AVAILABILITY Custom form 

PART COMPLEXITY Standard 

Use the default values for load factor, overhead rate, and capital write-off time. 

❖ Set the RECORD NAMING values: 

MATERIAL PP 

PRIMARY PROCESS molded 

❖ Create the new records. 

Click Create. Keep the Part Cost Estimator window open. 

The new synthesized records will be shown in the Results list and on the Chart Stage. 

❖ Add another material process. 

In the Part Cost Estimator window, click Previous and set the COMPONENT DETAILS for 
another material processing chain: 

MATERIAL YS170 (hot rolled) high strength steel 

PART MASS 10 

Use the default values for scrap material value, part length, batch size, and number of values 
(retained from the first material processing chain input). 
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❖ Set the PRIMARY SHAPING PROCESS values: 

PRIMARY PROCESS Hot shape rolling 

Use the default values for the other properties. 

❖ Set the SECONDARY SHAPING PROCESS. 

Select Include secondary process, and enter the following value: 

SECONDARY PROCESS Press forming 

Use the default values for part complexity, amount of scrap, and scap recycled. 

❖ Set the RECORD NAMING values: 

MATERIAL Steel 

PRIMARY PROCESS rolled 

SECONDARY PROCESS pressed 

❖ Click Create and then Finish to create the synthesized records and close the Part Cost 
Estimator. 

Synthesized records created using Part Cost Estimator are appended to the MaterialUniverse 
tree under My records > Synthesized > Part cost estimator. 

❖ Create a bubble chart to compare the two material processing chains. 

Click Chart/Index and set the following x- and y-axis values: 

CATEGORY Part cost estimator 

X-AXIS ATTRIBUTE Batch size 

Y-AXIS ATTRIBUTE Part cost 

❖ Change the record color for easy comparison of the two processing chains. 
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On the MaterialUniverse browse tree, navigate to My records > Synthesized > Part cost 
estimator.  

Right-click the PP, molded subfolder, click Record color, and click a color to change the 
record color for all records in that folder.   
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